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IFAS Navigation 
 
 
 
 
 
 
 
 
Navigation Bar and Options Menu: 
 
 
 

 
 
 
 
 
 
To Log Out from your current IFAS session: 
 
 

 
 
 
 

 
 
 
 
 

Using Screen Menus – Main Screen 

 
The on-screen menus have several functions that are available to campus users. 

Main Screen 
Options Menu 

Not available to 
campus users 
Not available to 
campus users 
Not applicable 
to campus users 

Click for the 
Options menu 

Click Log Out 

At this point, you can 
close Internet Explorer. 

However, if you wish to 
return to IFAS and log back 
in, click here. On some browser installations, logging out returns 

to the IFAS menu instead of the login screen. If 
this happens, you are not logged in and the system 
will not work. Close all open Internet Explorer 
windows, and reconnect for a new session. 

Navigation 
bar 
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To change your IFAS password: 
 

 
 
 
 

 
 
 
 
Settings… 
 

 
 
On-line Help 
 

 

Click for the 
Options menu 

Click Change 
Password 

In the dialog box, type in your 
old password, and your new 
password twice, as indicated. 

Then click OK 

Settings dialog 
does not apply to 
campus users. 

Navigation Help .pdf file 
is available on-line. 
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Report Viewer Screen 
Options Menu 
 
 
 
 
 
 
 
 
 
Report Viewer Navigation bar: 
 

 
 
 
Navigation: 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 

Not used 
Page navigation 
“VCR” buttons 

Report Viewer 
Options menu 

Export to .pdf 

Report title Report creation 
status 

Report page 
shown 

Using Screen Menus – Report Viewer Screen 

 
The report viewer screen menu allows navigation through the report, as well as printing and export. 

Make sure 
report is 

complete before 
navigating 
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Printing a report: 
 

 
 
 
 
 
 

 
 
 
 
 
 
The Internet Explorer Print dialog box opens.  
 
 

 

Click on 
Options 

Click on Print 

Choose the 
appropriate 
options, then 
click Print. 

Do not 
print from 
this IE icon 
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Print Preview: 
 
 

 
 
 
 

 
 
 
 

Click on 
Options 

Click on Print 
Preview 

Click on Zoom In or 
Zoom Out to change the 
magnification. Or you 
may type a number in the 
box and press enter. 
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Exporting a report to Excel: 
 
 
 

 
 

See next page for more details on exporting to Excel. 
 
 
 
 
 
 
 
 
Exporting a report to Adobe .pdf format: 
 

 
 
 
 
Other options: 
 
 

 
 
 

Click on 
Options 

Click on 
Options 

File attachments are not 
used in IFAS reports.  

Click on Export, 
then Excel 

Click on Export, 
then PDF 

About shows the 
program version.  
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Exporting to Excel (details) 
 
 
 
 
 
 
 
Step !: Run the 
appropriate report and 
move to end of report 
before downloading. 
 
Step ": Click on the 
Options dropdown. 
 
Step #: Click Export, 
then Excel 
 
Step $: Note that the 
spreadsheet is displayed 
within Internet Explorer. 
To manipulate the 
spreadsheet (like sorting): 
 
Step %: Click File > 
Save As…  
 
Step &: Under Save as 
type:, choose Microsoft 
Excel Workbook. 
Choose the destination 
folder and filename (as 
you would in saving any 
Excel file), then click 
Save. 
 
 
Once this has been saved 
as an Excel spreadsheet, 
it can be opened in Excel 
for manipulation and use. 
 

 
 
 

 
 

 

 

Exporting to an Excel Spreadsheet 

 
Reports can be exported to an Excel spreadsheet for ease in manipulation. This page describes the 
basic procedure for exporting IFAS reports to Excel. However, some reports that have 
numerous column headings have a special procedure, described on page 62 of this 
Manual, that will yield a more organized result. 

" 

# 

$ 

% 

& 

# 
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Entering Search Criteria 
 
 
 
 
 
 
 

 

  
Account number: IFAS account number. More than one account number may be included, separated by 
commas. 
Key word in fund name: must be entered as all CAPS, surrounded by asterisks. In our example for the 
Flowers Memorial Trust, we would enter  *FLOWERS*  .  
 

Hint: In entering two words, separators can create logical filters.   
' *SUE* *SUMMERS* (with a space between the words) returns items with both SUE 

and SUMMERS in the name.  
' *SUE*,*SUMMERS* (with a comma between the words) returns items with either 

SUE or SUMMERS in the fund name (including TISSUE). 
 
Academic Unit, Account Type Grouping, Campus Location, FAR Title, Purpose: The code 
number(s) may be typed in, separating multiple numbers with commas, or values may be chosen from 
the drop-down pick list. See the appropriate Account Attribute report for valid codes. 
 
 

 
 
 

If you enter data in any criteria box, you 
must remove the asterisk wildcard (*). 
Otherwise the asterisk must remain. Every 
box must contain * or a data entry. 

Pick-list 
dropdown 
buttons 

Using the pick list: Click 
on the items to choose 
them, then click OK to 
insert the data in the 
criteria box. 

Using the pick list: Click 
on the items to choose 
them, then click OK to 
insert the data in the 
criteria box. 

It’s best to type in the date in the format indicated. 
The dropdown calendar is not reliable. 

Special codes are CAPS only 

Entering Search Criteria 

 
Many reports will require that you enter some sort of criteria to narrow your account selection. Here 
is a typical example: 
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Reports 
Campus Reports 
Account Background 
 
 
 
 
 
 
Each KU Endowment fund account is assigned certain attributes based on its purpose (such as 
scholarships), the unit/academic area which it supports (such as the College of Liberal Arts and 
Sciences), the campus that it is intended to benefit (such as the Edwards Campus), and other criteria that 
are helpful to organize the accounts into similar groupings. 
 
Several of the financial reports that are provided in the IFAS system contain dropdown menus that allow 
you to sort the accounts in your area by these attributes; however, some of the reports do not have the 
handy dropdown menu capability. 
 
The Account attribute reports in this section of the system provide you with a description of all of KU 
Endowment’s attribute code numbers that can be used to aid in searching for the funds in your area. 
 
Please note that your user ID and password allows you to view data only for the fund accounts that 
relate to your specific unit/academic area. 
 

Account Background 

 
The Account Background section contains reports of Account Attributes for entering search criteria, 
information about specific accounts, and listings of accounts. 
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Account Attributes – Academic Unit 
 
 
 
 
 
  

 
Sample report: 
 

 
 
How to get this report: 
 

 
 
 
 
A 

 
 

Account Attributes – Academic Unit 

 
This report is a listing of valid codes that can be used to fill in the selection criteria “Academic Unit” 
on other reports. The codes are grouped by department within each School or Unit. This list can be 
downloaded to an Excel file for sorting. The Account Type Grouping criteria is also available as a 
dropdown “pick list” on some reports (see Account Information report). 

Click 
Submit 
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Account Attributes – Account Type 
 
 
 
 
 
 
 
 
Sample Report:   
 

 
 
How to get this report: 
 

 
 
 
 
 
 

Click 
Submit 

Account Attributes – Account Type 

 
This report is a listing of valid codes that can be used to fill in the selection criteria “Account Type“ 
on other reports. For instance, selecting account type 31, 32 would return only pending endowed 
fund accounts in the selected report. The Account Type criteria is available only on certain reports, 
such as the Account Listing/Lookup report. 
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Account Attributes – Account Type Grouping 
 
 

 
 
 
  

 
 
Sample report: 
 

 
 
 
How to get this report: 
 

 
 
 
 
 
 
 
 
 
 
 

 

Account Attributes – Account Type Grouping 

 
This report is a listing of valid codes that can be used to fill in the selection criteria “Account Type 
Grouping” on other reports. For instance, account type 2 would return only endowed fund accounts 
in the selected report. The Account Type Grouping criteria is also available as a dropdown “pick list” 
on some reports (see Account Information report). 

Click 
Submit 
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Account Attributes – Campus Location 
 
 
 
 
 
 
 
 
Sample report: 

 

 
 

How to get this report: 
 

 
 

 
 
 
 
 
 
 
 
 

Account Attributes – Campus Location 

 
This report is a listing of valid codes that can be used to fill in the selection criteria “Campus 
Location” on other reports. For instance, account type 5 would return only accounts for the Edwards 
Campus location. The Campus Location criteria is also available as a dropdown “pick list” on some 
reports (see Account Information report). 

Click 
Submit 
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Sample report: 
 

 
 
 
How to get this report: 
 

 
 

Account Attributes – FAR Title 

 
This report is a listing of valid codes that can be used to fill in the selection criteria “FAR Title” on 
other reports. The FAR Title criteria is also available as a dropdown “pick list” on some reports (see 
Account Information report). 

Click 
Submit 
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Account Attributes – Major Academic Unit 
 
 
 
 
 
 
 
 
 
Sample report:  
 

 
 
How to get this report: 
 

 

Account Attributes – Major Academic Unit 

 
This report is a list of valid codes that can be used to fill in the selection criteria “Major Academic 
Units” if you have responsibility over more than one department.  For example, if you need to run 
reports for the School of Medicine and include all the departments under the school, you would 
select code 24 for major academic unit rather than selecting all the individual Academic codes. 

Click 
Submit 
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Account Attributes – Purpose 
 
 
 
 

 
 

 
 
 
Sample report: 
 

 
 
 
How to get this report: 
 

 
 
 

Account Attributes – Purpose 
 

This report is a listing of valid codes that can be used to fill in the selection criteria “Purpose” on 
other reports. For example, Purpose Code 07 returns only accounts with no restrictions on its use 
other than to benefit the area specified as the account’s Academic Unit. The Purpose criteria is 
also available as a dropdown “pick list” on some reports (see Account Information report).  

Click 
Submit 
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Sample report: 
 

 
 
How to get this report: 
 
 

 
  

 

Account Information 

 
The Account Information report lists the various attributes that have been assigned for a specific 
fund account. 

Fill in these criteria to 
obtain the correct report. 
(Information on input 
criteria on the next page.) 

Then click 
Submit 
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Account number: IFAS account number. More than one account number may be included, separated by 
commas. 
Key word in fund name: must be entered as all CAPS, surrounded by asterisks. In our example for the 
Flowers Memorial Trust, we would enter *FLOWERS*.  
 

Hint: In entering two words, separators can create logical filters.   
' *SUE* *SUMMERS* (with a space between the words) returns items with both SUE and 

SUMMERS in the name.  
' *SUE*,*SUMMERS* (with a comma between the words) returns items with either SUE or 

SUMMERS in the fund name (including TISSUE). 
 
Account Status: This option allows you to select only active accounts (A) or all accounts whether open 
or closed (*) 
Item Type: For scholarship accounts, the item type number from PeopleSoft that identifies the 
scholarship. 
Academic Unit, Account Type, Account Type Grouping, Campus Location, FAR Title, Purpose: 
The code number(s) may be typed in, separating multiple numbers with commas, or values may be 
chosen from the drop-down pick list. See the appropriate Account Attribute report for valid codes. 
 

  
If you are selecting more than one code, hold the Ctrl key and click on the codes that you wish to select.

If you enter data in any criteria box, you 
must remove the asterisk wildcard (*). 
Otherwise the asterisk must remain. Every 
box must contain * or a data entry. 

Pick-list 
dropdown 
buttons 

Using the pick list: Click 
on the items to choose 
them, then click OK to 
insert the data in the 
criteria box. 

Using the pick list: Click 
on the items to choose 
them, then click OK to 
insert the data in the 
criteria box. 

Account Information criteria 

 
Certain criteria must be filled in to obtain the correct report. Remember that only reports within your 
security profile can be run. 
 
Here’s how to set up the reporting criteria: 
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Account Listing/Lookup 
 
 
 
 
 
 
 
 
Sample report: 
 

 
 
 
How to get this report: 
  

 
 
 

Account Listing/Lookup 

 
This report provides a synopsis of a group of accounts listing the IFAS account number and name, 
the account’s open/close date, and the old system account number.  The report also provides a 
search for new funds by entering a date in the Accounts opened after this date field.  

Selection criteria is similar to 
the Account Information report 
with the addition of scholarship 
attribute questions. 

Then click 
Submit 
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Accounts Payable 
 
 
 
 
 
 
 
 
 
 
The Vendor Lookup report provides the Vendor number to use in looking up payments or for use in 
identifying a vendor to use in Workflow.    
 
The Vendor Payment Summary Campus and the Vendor Payments report provide more detail about a 
group of payments or a single payment to a Vendor using various selection criteria including account 
number, amount, and invoice number. 
 
The Workflow Check Request Status contains information relevant to an electronic check request and 
where the request is in the process of being paid.  
 
The Workflow Transfer Status provides similar information to the Workflow Check Request in regards 
to a transfer request to move funds from one IFAS account to another IFAS account.   
 
 
Note: Please contact the KU Endowment Account Services staff if your unit wants to initiate the 
 Workflow electronic transaction process. 
 

Accounts Payable 

 
The Accounts Payable section contains reports to find vendor information, paid invoices, check 
numbers and other information relating to check requests.  If you utilize the automated Workflow 
procedure to initiate your payment request, the Accounts Payable folder contains reports to check 
on the status of your Workflow check request procedure to initiate your payment request (or 
transfer request).  
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Vendor Lookup 
 
 
 
 
 
 
 
Sample Report:  
 

 
 
How to get this report: 
 
 

 

Use Capital letters without punctuation, 
enter a key word in the vendor name.  
Place the wildcard* character before and 
after the key word in order to return all 
vendor names with the selected key word. 

Then click 
Submit 

Vendor Lookup 

 
This report provides a listing of Vendors by select search criteria, including name, address and 
Employer Identification Number (EIN).  The report provides you with the vendor number, name and 
different mailing addresses (note address code) if applicable.  Also please note that only the last 
four digits of an individual’s social security number will be displayed. 
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Vendor Payments 
 
 
 
 
 
 
 
Sample Report: 
 

 
 
 
How to get this report: 
 

 
 
 
 

Vendor Payments 

 
This report details payments made to vendors. It includes amount of the payment, KU Endowment 
check number, and date paid for the range specified.  It also contains drills to cross reference to 
other details about the payment. 

Enter Start Date, ending date and other 
selection criteria.  At least one other 
criteria item should be entered. 

Then click 
Submit 
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Vendor Payment Summary 
 
 
 
 
 
 
 
 
Sample report: 
 

 
 
 
To get this report: 
 
 

 
 
 

Vendor Payment Summary 

 
The Vendor Payment Summary report provides a simple report by date of all payments made to 
selected vendors from all accounts for the user’s security profile.   
 

Enter date range, vendor number and 
other appropriate criteria. 

Click  
Submit 
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Workflow Check Request 
 
 
 
 
 
 
 
 
Sample report: 

 

 
 
 
 
To get this report: 
 

Workflow Check Request  Status 

The Workflow Check Request Report provides information on the status of a request for payment 
processed through the automated Workflow process.  Using the appropriate selection criteria, you 
can find the person who is currently approving or processing the request by looking at the Current 
Desk Box.  If the check has been created, the Current Desk Box is empty and the date and Time will 
be marked under Completion Time.   
 

Enter date and other appropriate 
selection criteria. 

Click  
Submit 
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Workflow Transfer Request 
 
 
 
 
 
 
 
 
 
Sample report: 
 

 

 
 
To get this report: 
 

 

Workflow Transfer Request 

 
The Workflow Transfer Request contains information about the status of a transfer between IFAS 
funds that is requested through the automated Workflow process.  The report shows whose desk 
the transfer request is on under the Current Desk box.  If the transfer is complete, the date and 
time appear under the Completion Time field. 
 

Enter date and other appropriate 
selection criteria. 

Then Click  
Submit 
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Financial Statements 
 
 
 
 
 
 
 
 
 
The Balance Sheet reports assets held in the account, liabilities that it may owe, and the fund balance, 
all as of the date selected.  The report also shows the amount that is expendable and the invested balance 
that is not available for expenditure. 
 

Balance Sheet “A”: Report for a single account.  Also provides the donor contribution 
amounts on endowed accounts (required to comply with Kansas 
UPMIFA law). 

 
Balance Sheet “B”: A composite summary for multiple accounts 
 
Balance Sheet “C”: A report on a per account basis for a group of funds with common 

attributes, such as academic area or purpose. 
 
The Income Statement provides summarized information on revenue and expense transactions for a 
period of time (like a monthly statement). 
 

Income Statement “A”: Report for a single account 
 
Income Statement “B”: A composite summary for multiple accounts 
 
Income Statement “C”: A report on a per account basis for a group of funds with common 

attributes, such as academic area or purpose 
 
 

Any of the above reports can easily be downloaded to Excel in a relatively similar format as the on-
screen report.  Please see the FAQ (next) section of this manual.

Financial Statements 

 
The Financial Statements have variations on two basic reports:  a balance sheet and an income 
statement.  
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Balance Sheet A – single account 
 
 
 
 
 
 
 
Sample report: 

 
 
How to get this report: 

 
  

Financial Statements – Balance Sheet “A” 

 
The Balance Sheet “A” reports assets held in a single account, liabilities that the account may owe, 
and the account’s fund balance, all as of the date selected. The report also shows for these amounts 
the portion of the account that is expendable in a column separate from the invested balances that 
are not available for expenditure. 

Enter ending date of 
report and the account 
number (remove the * ). 

Then click 
Submit 
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Balance Sheet B – composite summary of multiple accounts 
 
 
 
 
 
 
Sample Report: 

 
 
How to get this report: 
  

Financial Statements – Balance Sheet “B” 

 
The Balance Sheet “B” is a composite single-page summary of multiple accounts that share the 
same selection criteria. It looks identical to Balance Sheet “A”, but the totals are for multiple 
accounts. For your reference, the search criteria are printed at the end of the report. 

Enter ending report date and other appropriate 
criteria. At least one other criteria item should 
be entered (remove the * ). 

Then click 
Submit 
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Balance Sheet C – list of multiple accounts 
 
 
 
 
 
 
 
 
Sample Report: 

 
 
 
 
 
How to get this report: 

 
  
 

Financial Statements – Balance Sheet “C” 

 
The Balance Sheet “C” report provides assets liabilities and fund balances on a per account basis for 
a group of funds with common attributes, such as academic area or purpose. For your reference, 
the search criteria are printed at the end of the report. This may be a multi-page report, depending 
on the number of accounts selected.  You may sort this report alphabetically or numerically. 

Then click 
Submit 

Enter ending report date and other appropriate 
criteria. At least one other criteria item should 
be entered (remove the * ). 
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Income Statement A – single account 
 
 
 
 
 
 
 
Sample report: 

 
 
How to get this report: 
 

 

Financial Statements – Income Statement “A” 

 
This report shows income and expenses for a single account for a given period of time. The second 
column shows comparison information for the account for the same period of the previous year. 
Total revenue and expenses for the selected reporting period are included in the Account Summary 
at the bottom of the report.  

Enter the date range for the reporting 
period and the account number 
(remove the * ). 

Then click 
Submit 
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Income Statement B – composite summary of multiple accounts 
 
 
 
 
 
 
 
Sample report: 

 
How to get this report: 
 

Financial Statements – Income Statement “B” 

 
This is a single-page composite summary for multiple accounts that share the same selection criteria 
for a given period of time. It is identical to Income Statement “A”, but the amounts reported are for 
multiple accounts. For your reference, the search criteria are printed at the end of the report. 
 

Then click 
Submit 

Enter Start date, ending date and other 
selection criteria. At least one other criteria 
item should be entered (remove the * ). 
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Income Statement C – list of multiple accounts 
 
 
 
 
 
 
Sample report: 

 
How to get this report: 

 

Financial Statements – Income Statement “C” 

 
This is a multi-page report that shows income and expenses for multiple accounts (each one its own 
page) that share the same selection criteria for a given period of time. The format of each account 
page is the same as Income Statement “A”. For your reference, the search criteria are printed at the 
end of the report. 

Then click 
Submit 

Enter Start Date, ending date and other 
selection criteria. At least one other criteria 
item should be entered (remove the * ). 
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G/L Transactions 
 
 
 
 
 
 
 
Entries that affect spendable cash balances may be found in the Cash (Spendable) Transaction 
Statement. This report may be used as a check register to track spendable cash receipts and 
disbursements for an account. 
 
All entries to an account, including cash and non-cash transactions, may be found in the Transaction 
Statement.  The report identifies the transaction as a debit or a credit and places the entry into either the 
Spendable or Invested sections to track changes in both cash and investment balances. A summary entry 
at the end of the month shows net changes in market value for the report period if the account holds 
assets in the Long Term Investment Pool. 
 
Information about payments from the account may be found in the Vendor Payments report and 
provides you with an easy way to access information for a particular payment without looking at all 
transactions. 
 
The sub-folder entitled Download to Excel of G/L Transactions contains one additional report: the 
Transaction Summary by Account and Expense Object.  It was developed for departments with large 
numbers of accounts to monitor expenses for all accounts by KU Endowment expense object code. 

G/L Transactions 

 
The G/L (General Ledger) Transaction folder contains reports to identify some or all of the entries 
recorded in an account. A brief description of the transaction will be found along with dates and 
dollar amounts. 
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Cash (Spendable) Transaction Statement 
 
 
 
 
 
 
 
Sample report:  
 

 
 
How to get this report: 
 

Cash (Spendable) Transaction Statement 

 
This report shows transactions that affect the account’s cash balance during the selected date 
range. The summary at the end of the report shows the changes made to the cash balance and how 
much is available to spend at the end of the report period. 

Enter Start Date, ending date and other 
selection criteria. At least one other 
criteria item should be entered. 

Then click 
Submit 

Do not download this report. Print only. 
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Transaction Statement 
 
 
 
 
 
 
 
 
Sample report: 
 

 
 
How to get this report: 
 
 

 

Transaction Statement 

This report provides details about all of the entries recorded against the selected account for the 
date range specified. It is recommended that you select dates that are the beginning and end of the 
month. The report may be run in date order (D) or by financial statement description order (S). 
Changes in market value of the account’s assets in the Long Term Investment pool that have been 
recorded for the period selected are shown as a summary entry at the end of the report. 

Then click 
Submit 

Enter Start Date, ending date and other 
selection criteria. At least one other 
criteria item should be entered. 

Do not download this report. Print only. 
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Management Reports 
 
 
 
 
 
 
 
 
 
The first folder, General Accounts contains two versions of an Account Usage report, one on a per-
account basis and the other with accounts summarized by Department.  The Account Usage Summary 
by Account report can be run for any time period, for a single account or group of accounts.  The 
Account Usage Summary by Dept. can also be run for any time period for a single department or a 
group of departments and will return a summary of activity by department. 
 
This folder also has a report that provides information about endowed accounts that have a current 
investment value that is less than the account donor’s original contribution.  These “underwater” 
accounts should be monitored in accordance with the Kansas Uniform Prudent Management of 
Institutional Funds Act (UPMIFA). 
 
The second folder is restricted to Scholarship Accounts only and is intended to provide Account Usage 
Summary information in the same form as described for the General Accounts, above, but the data is 
based on the scholarship spending year – 02/28/XX through 02/27/XX. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Management Reports 

 
These reports are intended to help persons who are responsible for University units by providing 
various analytical reports, about the accounts within the Unit, such as an overview of cash balances 
used over a period of time.  
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Account Usage Summary by Account 
 
 
 
 
 
Sample Report: 
 

 
 
 
 
To get report:  
 

 
 
 
 
 
 
 
 
 
 
 

Choose an academic unit or leave 
blank to return all accounts 

Click on 
Submit 

Account Usage Summary by Account 
 
This report provides for each account, a summary of cash additions by major category to an 
account and a summary of cash uses by major category for the time selected. 
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Account Usage Summary By Dept. 
 
 
 
 
Sample report: 
 
 

 
 
 
 
To get report: 
 
 

 
 
 
 

Choose an academic code within your 
school or leave blank to return all 
accounts for your access. 

Click 
on 
Submit 

 

Account Usage Summary by Dept 

 
This report provides for each department, a summary of cash additions by major category to an 
account and a summary of cash uses by major category for the time selected. 
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UPMIFA – Underwater Funds 
 
 
 
 
 
 
 
 
 
 
Sample report: 
 

 
 
 
To get report: 
 

 

UPMIFA – Underwater Funds 

 
This report provides information on funds that are subject to the Uniform Prudent Management of 
Institutional Funds Act (UPMIFA).  The report will identify endowed accounts whose Long-Term 
Investments Pool (LTIP) market value is less than the historical donor contribution amount.    
 

Enter date of report and other criteria. 
Entering the date only will return all 
accounts that are underwater that you 
have access to view. 

Click on 
Submit 
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Account Usage Summary by Account (Scholarship) 
 
 
 
 
 
 
  
 
 
Sample report: 
 

 
 
 
 
To get report: 
 
 

 
 
 

 

Enter date of report and other criteria. 
Entering the date only will return all 
accounts that you have access to 
review.  

Click on 
Submit 

Account Usage Summary by Account (Scholarship) 

 
This report provides the summary cash additions to a scholarship account and the summary uses for 
each scholarship for the time selected.  Because the scholarship spending year is 02/27/XX, the 
report will begin at the scholarship year 02/28/XX prior to the Expense End Date selected.   
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Scholarship Account Usage Summary by Department (Scholarship) 
 
 
 
 
 
  
 
 
 
Sample report: 
 

 
 
 
To get report: 
 

 

 
 
 

Select report date and enter criteria. If 
you select date only, all departments 
that you have access to will return. 

Click on 
Submit 

Account Usage Summary by Department—(Scholarship) 

 
This report provides an aggregate summary of cash additions and uses for each department’s group 
of scholarship accounts for the time selected.  Because the scholarship spending year is 02/28/XX, 
the report will begin at the scholarship year 02/28/XX prior to the Expense End Date selected.    
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Projected Income  
 
 
 
 
 
 
The first of the three reports in this section is applicable to any account that has assets invested in KU 
Endowment’s Long-Term Investment Program. It reports the specified account’s most recent monthly 
income distributions from its Long-Term Investments, which is KU Endowment’s best estimate of 
future investment distributions as well.  
 
The last two reports develop a projection of scholarship resources that may be offered to students for 
each academic year, and paid scholarships that have been charged against this projection budget. 
 
 

Projected Income 

 
These reports estimate future income for any account that has assets in KU Endowment’s Long 
Term Investment Pool, and projected income that will be available from accounts dedicated for 
scholarship purposes. 
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Income from Long Term Investment Program 
 
 
 
 
 
 
 
 
Sample report: 
 

 
 
 
 
How to get this report: 
 

 
 

Income from Long Term Investment Program 

 
This report details how much is available for spending as of the report date, as well as how much 
investment income the fund is expected to earn from its LTIP balance on a monthly basis. This 
information can be used as a tool to plan for future spending. 

Then click 
Submit 

Enter the Report Date (required) and at 
least one other criteria item. 
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Scholarship Projection 
 
 
 
 
 
 
 
Sample report: 

 

 
 
How to get this report: 
 

 

Scholarship Projection 
 

This report shows approximately how much will be available to spend from scholarship funds in a 
given year, and any donor direction about the use of the funds. Preliminary projections are available 
each year by November 15, and final projection budgets are available by March 10.  Please refer to 
the report footnotes for a detailed explanation of KU Endowment’s methodology for projecting 
scholarship resources. 

Then click 
Submit 

Enter the Academic Year (required) 
and at least one other criteria item. 

PeopleSoft number 
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Scholarship Projection Usage 
 
 
 
 
 
 
 
Sample report: 

 
 

How to get this report:  

 

Scholarship Projection Usage 

 
This report shows the full scholarship projection budget for the current period, how much has been 
spent, and how much remains of the projection budget as of the date selected.  The footnotes of 
the report provide further information about the data in the report.  

Then click 
Submit 

Enter the Expenses End Date 
(required) and at least one other 
criteria item. 
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KU Endowment 
Account Reporting System 

 
IFAS 

www.kuendowment.org/ifas 
Frequently Asked Questions 
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Report Criteria ...............................................................................................................................54 

Where do I find the criteria that many of the reports require as selection options? 
 
Accounts ........................................................................................................................................55 

How do I find out the names and numbers for accounts benefiting the unit/department/school? 
 
FARs ..............................................................................................................................................56 

How do I find out the restrictions on usage on an account, or who the fund account 
representative is? 

 
Account balance.............................................................................................................................57 

How do I find the fund balance of an account? 
 
Groups of funds .........................................................................................................................58 
How do I find a composite balance sheet for a group of funds, for example: the total of all 
scholarship funds for my area? 
 
Multiple account balance sheets ..............................................................................................59 
How do I find the balance sheet for multiple accounts without running separate reports? 

 
Income statements..........................................................................................................................60 

How do I find a statement summarizing expenses and income year to date or month to date for 
a single account? 
How about for a group of accounts? 
 
Multiple account income statements..........................................................................................61 
How do I find a statement summarizing expenses and income year to date or month to date for 
multiple accounts without running separate reports? 

 
Reports in Excel.............................................................................................................................62 

How do I export a balance sheet or Income Statement to an Excel file? 
 
Transactions ...................................................................................................................................64 

How do I find all the transactions for an account for a certain time period? 
How do I find transactions that have only affected cash balances? 
How do I find a specific transaction that affects a specified account’s cash balance?..............65 

 
Troubleshooting ...........................................................................................................................66 
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Report Criteria 
Where do I find the criteria that many of the reports require as selection options? 
 
 
 
 
 
 
 
The Account Background folder contains lists of attributes that define Endowment accounts. There are 
six attribute lists: 
 

 
 
 
Run these reports to see a list of the attribute codes. 
 
 

Report Criteria 

 
Where do I find the criteria that many of the reports require as selection options? 
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Accounts 
How do I find out the names and numbers for accounts benefiting the unit/department/school? 
 
 
 
 
 
 
The Account Listing report contains a simple list of accounts for your area. Navigate to Reports > 
Campus Reports > Account Background > Account Listing/Lookup 
 

 
 
 
For instance, enter your Academic Unit code (or codes, separated by commas) or choose it from the 
picklist dropdown. Click submit to get a listing of accounts for that code. 
 
 
Remember that you can only see reports on accounts within your Unit/Department. 
 

Accounts 

 
How do I find out the names and numbers for accounts benefiting the unit/department/school? 
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FARs 
How do I find out the restrictions on usage on an account, or who the fund account representative is? 
 
 
 
 
 
 
The Account Information report contains information on how the fund is used, the type of account, and 
who the FAR is on the account. Navigate to Reports > Campus Reports > Account Background > 
Account Information. 
 

 
 
For instance, here is a sample report for the Flowers Memorial Trust: 
 

 

Fund Account Representatives 

 
How do I find out the restrictions on usage on an account, or who the fund account representative 
is? 
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Account balance 
How do I find the fund balance of an account? 
 
 
 
 
 
 
Navigate to Reports > Campus Reports > Financial Statements > Balance Sheet A 
 

 
 
Enter the date into the Report Date field using the format MM/DD/YYYY. (We recommend that you 
type in the date and not use the dropdown calendar for entering the date.) 
 
Delete the asterisk in the Account Number field, and type in the account number. Then click Submit. 
 

 

Account balance 

 
How do I find the fund balance of an account? 
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Groups of funds 
How do I find a composite balance sheet for a group of funds, for example: the total of all scholarship 
funds for my area? 
 
 
 
 
 
Navigate to Reports > Campus Reports > Financial Statements > Balance Sheet B 
 

 
 
Enter the Report Date (type it in; we recommend not using the date dropdown). Then enter your 
selection criteria, and click Submit. As an example, we have entered Academic Unit 760000 (Fine Arts) 
and Purpose 21 (scholarships) for this report: 
 

 

Groups of funds 

 
How do I find a composite balance sheet for a group of funds, for example: the total of all 
scholarship funds for my area? 
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Multiple account balance sheets 
How do I find the balance sheet for multiple accounts without running separate reports? 
 
 
 
 
 
 
Navigate to Reports > Campus Reports > Financial Statements > Balance Sheet C 
 

 
 
Enter Report date and other selection criteria. Then click Submit.  
 

 

Multiple account balance sheets 

 
How do I find the balance sheet for multiple accounts without running separate reports? 
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Income statements 
How do I find a statement summarizing expenses and income year to date or month to date for a single 
account? 
How about for a group of accounts? 
 
 
 
 
Single account: Navigate to Reports > Campus Reports > Financial Statements > Income Statement A 

 
 
Multiple accounts: Reports > Campus Reports > Financial Statements > Income Statement B 

 
 
Enter beginning and ending dates by typing in the data. Then select other appropriate criteria, and click 
Submit. 
 
Remember that you can only see reports on accounts within your Unit/Department. 

Income statements 

 
How do I find a statement summarizing expenses and income year to date or month to date for a 
single account? 
 
How about a summary for a group of accounts in one report? 
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Multiple account income statements 
How do I find a statement summarizing expenses and income year to date or month to date for multiple 
accounts without running separate reports? 
 
 
 
 
 
Navigate to Reports > Campus Reports > Financial Statements > Income Statement C 
 

 
 
Enter beginning and ending dates by typing in the data. Then select other appropriate criteria, and click 
Submit.  A report for each account that you have selected to view will appear. 
 

 

Multiple account income statements 

 
How do I find a statement summarizing expenses and income year to date or month to date for 
each account without running separate reports? 
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Reports in Excel 
 
 
How do I export a balance sheet or Income Statement to an Excel file? 
 
 
 
 

 
 
Certain reports have been formatted for Excel.  If the report is formatted for downloading into an Excel 
sign, there will a Selection Criteria “Download to Excel? (Y or N) option.   
 
Select the report that you wish to download enter the appropriate criteria and select Y in the Download 
option. 
 

 
 

Reports in Excel 

 
How do I export a balance sheet or Income Statement to an Excel file? 

Look for the file and paperclip 
symbol at the top of the Tool Bar. 
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By clicking on the paperclip symbol,    the XLSGEN Output box appears.   
You will click on the box and the following dialogue box opens: 
 

 
Click open and your report will appear in an Excel spreadsheet: 
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Transactions 
How do I find all the transactions for an account for a certain time period? 
How do I find transactions that have only affected cash balances? 
 
 
 
 
 
All transactions: Reports > Campus Reports > G/L Transactions > Transaction Statement 
 

 
 
 
 
Transactions affecting cash balances: Reports > Campus Reports > G/L Transactions > Cash 
(spendable) Transaction Statement 
 

 
 
 
For both reports: Enter starting and ending dates. Enter other necessary search criteria and click Submit. 

Transactions 

 
How do I find all the transactions for an account for a certain time period? 
How do I find transactions that have only affected cash balances? 

Unit Budget Code 
available on transaction 
through Workflow only 
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How do I find a specific transaction that affects a specified account’s cash balance? 
 
 
 
 
 
 
 
 
Navigate to Reports > Campus Reports > G/L Transactions > Cash (Spendable) Transaction Statement 
 
Enter starting and ending dates.  
 
Enter the Account number(s).  
 
Enter other criteria to customize your search. If you are looking specifically for a transaction of 
$1,226.20, enter that number in the Transaction Minimum and Maximum fields. 
 

 
 
 

 

Transactions 

 
How do I find a specific transaction that affects a specified account’s cash balance? 
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Troubleshooting 
 
 
 
 
 
 
 
You are not getting the data that you expect or your report returned with no data. 
 
Here are several things to check: 
 

• The date or date format is incorrect.  Dates should be entered as MM/DD/YYYY. 

• The * (wildcard) sign was cleared out of a selection field without being replaced by a valid 
value. 

• The * (wildcard) sign was included in your selection, e.g. *07/01/2006. The * should always be 
replaced by valid selection values (except in the case of an account inquiry by key word, as 
follows). 

• You were searching by account name and failed to use all capital letters, e.g. *jones* should be 
*JONES* . 

• When searching by account name, you failed to surround the entry by *s, e.g. *JONES instead of 
*JONES* . 

• Your security does not give you access to the criteria selected. 
• The selection value was incorrect, such as a date of 07/01/1916. Complete data is only available 

beginning 05/01/2006. 
 
 
 
 
It takes many minutes for your report to display. 
 
You may have run a report with no selection criteria or a very broad range of criteria. If you wish to 
cancel, click the Cancel button on the Report Status dialog box. 
 

 

Troubleshooting 

 
If you are experiencing trouble with the IFAS system beyond what is documented in this and the 
other IFAS documentation, please call the KU Endowment. For technical help, call Information 
Systems Help Desk at 785-832-7388. For operational issues, please contact Account Services at  
785-832-7400. 

Click Cancel to 
stop report 
retrieval 
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You have exported a report to Excel and the information is scrambled on the Excel spreadsheet. 
 
Not all reports have been formatted to download correctly into an Excel spreadsheet.  The Financial 
Statements have a separate folder marked “Download to Excel of Financial Statements” which include 
formats for Excel spreadsheets.  Other reports may or may not download to Excel with the proper 
formatting depending on the layout of the report.   
 
 
 
 
Your on-screen report appears to be incomplete. 
 
Your report may be several pages long and you may have to click on the navigation arrow keys at the 
top of the report to view the succeeding page(s).  Check the right end of the Navigation bar to see how 
many pages your report contains. 
 
 

 
 
 
 
 
 
You requested to print an on-screen report from the Internet Explorer shortcut, and the report 
does not print correctly. 
 
You must print reports via the Options dropdown menu at the top of the Report Viewer screen and select 
Print. 
 

 
 
 
 
 
 

Report page 
shown 

Click on 
Options 

Click on Print 

Do not 
print from 
this IE icon 
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You printed a report and the printed version cuts off some of the information. 
 
You may have to change the print format.  Select File > Page Setup > Orientation > Landscape. Click 
OK and Print. You may also need to adjust the print margins 
 
 
 
 
You have connected to IFAS in the past, but are experiencing trouble now. 
 
Clear your Temporary Internet Files: In Internet Explorer, go to Tools > Internet Options  
 

 

 

 
 
See the Set Up instructions to make sure that all of your Temporary Internet Files are being cleared each 
time you leave Internet Explorer. 
 
 
 
 
The Reports windows are not appearing 
 
Make sure that your pop-up blockers are all turned off. See page 64, or contact your tech support person. 
 
 
 
 
Some printing controls do not work correctly. 
 
Make sure that the ActiveX controls have installed correctly. You may have to have Administrator 
security privilege on your computer to install the controls. Contact your local tech support person for 
assistance. 

General tab 

Under Temporary 
Internet Files, click 
Delete files. 

Then OK 
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KU Endowment 
Account Reporting System 

 
IFAS 

 
End-user Setup 

 
 
 
 
 Note: For this setup, please be sure to have your computer technician or other technical resource 
 handy. Some of these steps may require administrative security privilege to be correctly installed. 
 
 Also, please note that these instructions assume use on a PC and for Internet Explorer version 6 or 
 higher. Some of the features require ActiveX controls that are not available from other browsers or on 
 Macintosh. 
 
 
 
 Initial Set up 
 
 
 Before you connect to IFAS: 
 
 Before you attempt to connect to IFAS, there are a few settings that you will have to change in Internet 
 Explorer.  
 

 
 
 
 

In Internet Explorer, 
click on Tools > 
Internet Options 

In Internet Explorer, 
click on Tools > 
Internet Options 
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On the Security tab… 

Click Trusted Sites 

Then click Sites… 

1. Uncheck Require 
server verification… 

2. type: 
*.kuendowment.org 
and click Add. 

3. Click OK 
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To confirm settings, 
click Custom Level 

If it is not already listed, 
change settings to Low, 
click Reset, and OK. 
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On the Advanced tab 

Check the box 
Empty Temporary 
Internet Files… 
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Testing your set up 
 
The following procedure is for testing your setup only.  The username and password shown below is 
only for testing use.  Log into the IFAS server at this address: 
 

http://www.kuendowment.org/ifas 
 

 
 
 
 
 
 
 
 
 
 
 

Click OK. 

Close Internet Explorer and 
open it again for the setting 
changes to take effect. 

When all settings have 
been completed: 
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Third-Party Pop-up Blockers 
 
Although the Internet Explorer pop-up blocker has been turned off for this site (through the Trusted Site 
security settings), some third-party pop-up blockers, like the Google toolbar, do not have an editable 
“white list” of sites to allow.  Here is a tip on how to allow the pop-ups from reports: 
 

  
 
 
If your third-party pop-up blocker does have an editable white-list, add “*.kuendowment.org” or 
“kuea10.kuendowment.org” to the allowed domains. 
 
 
 

At the IFAS login screen, 
click the Popups button to 
allow pop-ups for the site. 

At the Connect to ifas 
screen, enter: 
User: campusus 
Password: campusus1 
click Login or press 
Enter. 

This login and password are for 
testing purposes only. You will be 
assigned your permanent login. 
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Click the “+” next to: Reports > Campus 
Reports > Account Background > Account 
Information. 

Click the “+” next to: Reports > Campus 
Reports > Account Background > Account 
Information. 

Click the “+” next to: Reports > Campus 
Reports > Account Background > Account 
Information. 

Click the “+” next to: Reports > Campus 
Reports > Account Background > Account 
Information. 

For the Account number 
enter: 30940 (remove the *) 

Click Submit 

A screen similar to this 
should appear as the 
report is generated. 
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ActiveX Controls 
 
When a report is first displayed on the screen, you may get this Security Warning: 

 
 

 
 
 
This installs an ActiveX program that controls the buttons on the toolbar on the Report page and printing 
controls. This is a program by SunGard/Bi-Tech (the authors of IFAS) that you can safely install.  Click 
the Install button to continue.  
 
Clicking “Don’t Install” will display the page, but portions will not work correctly.  
 
 
 

 

The report should look 
something like this. 
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' If the report did not display correctly, or if the reporting window did not appear, you may have a 

pop-up blocker still turned on. 
 

' If you are having trouble with the installation and if your technician is not able to help you, 
please contact the KU Endowment Association Help Desk at 785-832-7388. 

 
When you are done, close the report window (by clicking on the X in the upper right corner), and on the 
IFAS home page, logout: 
 

 
 
 
 
 
 
 
 
Desktop Icon Setup 
Please note: Creating an icon through Internet Explorer (File > Send > Shortcut to Desktop) or creating 
a Favorite in Internet Explorer may not work correctly. Access to this system is controlled by server 
redirection. 
 
 
To assist you in getting to the IFAS system, you can create a desktop shortcut icon: 
 

 
 
 

Click for drop-down 
menu 

Click Log Out 

Right-click on a blank area of 
the Desktop. On the mini-menu 
which appears: 
 
Click New > Shortcut 

Right-click on a blank area of 
the Desktop. On the mini-menu 
which appears: 
 
Click New > Shortcut 

Right-click on a blank area of 
the Desktop. On the mini-menu 
which appears: 
 
Click New > Shortcut 
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Type in: 
http://www.kuendowment.org/ifas 

Click Next 

Enter a meaningful name 
for the shortcut. 

Click Finish 


